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Chapter 1 • Introduction 

Description 
 
The MC3000-S from Symbol is a lightweight, rugged mobile computer with ergonomic 
design and flexible configurations. It features an Intel XScale PXA270 processor and a 
Microsoft Windows CE 4.2 operating system. A variety of feature options include 
wireless 802.11b/g LAN connectivity, a 320 x 320 resolution color / mono display (with 
backlight), a 38-key keyboard, an adjustable scan head with left, right, and front 
positions, and an internal antenna. The MC3000-S's IP54-rated sealing protects against 
dust, moisture, and extreme temperatures. This mobile computer has a drop spec of four 
feet to concrete. For more information, see: www.symbol.com 

Picture 

 

Setup Requirements 
Installation of PowerNet Twin Client requires, at a minimum, the following: 
• A Pentium-class processor 
• 32 MB of RAM  
• 10 MB of free hard disk space available 
• Microsoft Windows CE 4.2 or CE 5 operating system 

ActiveSync needs to be installed on the PC before downloading files to the terminal.  
For instructions, go to http://www.MSDN.Microsoft.com. 
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Introduction 

Accessories 
 
The following accessories can be ordered from Symbol: 
 

• Single-Slot Serial / USB Cradle (P/N: CRD3000-1000R) 

• Four-Slot Charge-Only Cradle (P/N: CHS3000-4000C) 

• Standard Capacity Spare Battery (P/N: BTRYMC30KAB01-01) 

• High Capacity Spare Battery (P/N: BTRYMC30KAB0H-01) 

• RS232 Communication / Charging Cable (P/N: 25-67866-01) 

• USB Client Communication / Charging Cable (P/N: 25-67868-01) 

• RS232 Communication Cable (P/N: 25-63852-01) 

• USB Client Communication Cable (P/N: 25-68596-01) 

• Wall Mounting Cradle Bracket (P/N: 8710-050006-01) 

• Fabric Holster (P/N: 11-69293-01) 

• Plastic Holster (P/N: 51-095051-86) 

• Four-Slot Spare Battery Charger (P/N: SACX000-4000C) 

• Universal Battery Charger (UBC) Adapter (P/N: 21-32665-45) 

Synchronization Tools 
 

At least version 3.1 of ActiveSync is required for desktop synchronization and 
communication.  ActiveSync is freely downloadable from the Microsoft web site,  
at http://www.microsoft.com/downloads.
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Chapter 2 • Terminal Setup 

Downloading from the Web 
The PowerNet Twin Client software package can be downloaded from the Connect web 
site at http://www.connectrf.com. Click on Partner Services and then click on Software 
Downloads. Select the file named PowerNet Twin Client for Symbol. 

Running Setup from a Download File 
The downloaded file is a compressed archive. After extraction using a utility such as 
WinZip or PKWARE, folders are created on the hard disk as shown in the following 
figure. 

 
 

Click on the Disk1 folder to view the files as shown in the following figure. 

 

Click on the Setup application and proceed to the following section entitled Installation 
for further instructions. 
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Terminal Setup 

Installation 
The InstallShield wizard runs and presents the following screen. 

 
Click on Next to begin the installation process. 

 
To change the default Destination Location, click on Browse and select a location. Then 
click on Next. 
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  Installation 

 

The default folder is PowerNet. This default may be changed either by selecting an 
existing program group or by typing in a new name at the prompt. Then click on Next. 

 
Read the warning. Select Yes to continue with the installation, or No to close the setup. 
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Terminal Setup 

 
 

When the installation is complete, reboot the system to initialize the Twin Client 
software. 

a. To reboot the system immediately, click on Finish. 

b. To reboot later, click on the option to restart the computer later, and click on Finish. 

Running the Manager 
The PowerNet Twin Client Manager is the utility that manages the terminal software and 
configurations. 

Select Start, Programs, PowerNet, and Twin Client Manager.  The PowerNet Twin 
Client Manager screen appears as shown in the following figure. This is the 
administrator's main screen, and all functions are accessed from its menu bar, toolbar, and 
tabs. 

Menu Bar 
The menu bar provides access to the functions used to configure the terminals and 
manage their software. 
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  Quick Start 

Toolbar 
Found under the menu bar, the toolbar provides shortcuts to major features. The toolbar 
can be turned on or off by changing the Toolbar parameter found on the View menu. The 
shortcuts available from the toolbar are as follows: 

 Create a new terminal configuration. 

 Open an existing terminal configuration. 

 Save the current terminal configuration. 

 Download the configuration to the terminal. 

 Download software to the terminal. 

 Configure terminals automatically over the wireless network. 

 View the PowerNet Twin Client Manager version. 

The PowerNet Twin Client Manager is now successfully installed and ready for use. The 
section below entitled Quick Start provides detailed instructions for quickly configuring 
the terminal and starting a Telnet session. 

Quick Start 
This section describes how to prepare the Twin Client Manager and the Symbol terminal 
for a Telnet session with the host. Following an initial serial download, the terminal 
software and configuration are managed automatically over the wireless network. 

Note: Symbol terminals are normally delivered with Symbol files pre-installed. However, 
if the terminal does not have those files installed refer to the section entitled 
Configuring the Terminal for Download before proceeding. 

Configuring the Manager 
The first step is to configure the Twin Client Manager to meet site-specific requirements, 
and then prepare it for the automatic management of the terminal software and IP 
addresses. This simple procedure will require only a few minutes to complete. 

Setting the Emulation 

Click on Start, Programs, PowerNet, and Twin Client Manager. Select the Settings 
menu, as shown below. 
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Terminal Setup 

 

Click on Emulation, select the desired emulation, and click on OK. 

 

Setting the Servers 

The Servers are the Telnet host systems the terminals will access. 
 

 

To set these addresses from the Settings menu, click on Servers. 
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  Quick Start 

 

Then click on Add. 

Note: Use the Load button if you want to load an .svr file. Use the Save As button if you 
want to save your file as an .svr file. 

 

Enter the name of each server, its IP address and IP port (normally 23 for Telnet servers), 
and emulation type. Click on OK. Repeat this step for each Telnet server the terminals are 
required to access. If an error is made in the name, IP Address, IP Port number, or 
Terminal emulation type, click on the line that is in error, and then click on the Edit 
button to make the corrections. 

Terminal AirLoader and AirBEAM Operations 

In the Twin Client menu under Settings, choose Terminal Operation. 
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Terminal Setup 

 

Run AirLoader on terminal can be selected, the AirLoader server IP address can be 
entered, and the Windows CE options of Run application at startup and Hide task bar 
can be selected, as shown below. Also, there is an option to Use GUI menus and 
screens that makes the terminal program act more "Windows-like". Click on OK after 
entering information. 

 

The Code page setting determines the Windows font code page that will be used on the 
terminal. The default is zero, which means that the terminal will use the standard Unicode 
code page. This option is necessary to turn on character sets for foreign languages. 

For more information on code pages, see the document entitled “Code Pages” at 
http://www.connectrf.com/faq.htm. 

See the AirBEAM Operation section in the Symbol Twin Client manual for instructions 
on the AirBEAM option in this screen. 

Setting Terminal Model and COM Port 

The terminal model is 3000_CE, and the default serial connection is through COM1. To 
select a specific Symbol terminal model and keypad, or to change the COM port 
assignment, click on the Options menu as shown. 
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  Quick Start 

 

To maintain compatibility with existing Symbol Telnet client keyboard layouts, a specific 
terminal model and keypad must be selected from the Terminal Model window. 

 
 

 
 

Select the 3000_CE terminal model option under Settings, Options, and Terminal 
Model.  

 
Note: Click on New the first time around to ensure that all defaults are set, especially    
          when changing emulations. 

Saving the Configuration 

Click on File and Save As. Enter a name for this configuration. 
 

 

For the purposes of this example, the name is vt100. 
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Terminal Setup 

 

Setting Airloader Auto-Configuration 

The configuration download and IP address assignment for each terminal will take place 
automatically by setting the Airloader Auto-Configuration options. 
 

 

Click on the Airloader option in the Tools menu. 

Note: If the Airloader Auto-Configuration window does not display the options, click on 
the Advanced<< button. 

If multiple network adapters are installed on the PC, ensure that the desired network 
adapter is selected. The adapter selection can be changed by clicking on the Change 
button. 
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  Quick Start 

 
 

This powerful software management tool is described in detail in the section entitled 
Airloader Auto-Configuration. For now, it is sufficient simply to use it for assignment of 
the initial terminal configuration and IP address, both of which can be easily changed 
later. Ensure that all of the check boxes are checked as shown above. 

To assign terminal IP addresses automatically over the wireless network, check all of the 
boxes as shown above. Then click on the Addresses button and enter the desired range 
in the From and To boxes as shown in the following figure. 

 

After setting the address range, click on OK to return to the Airloader Auto-Configuration 
screen and then click on the box next to Terminal/Group Manager. 
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Terminal Setup 

 

The display expands to show the default terminal group. Next, click on the New Group 
icon and use the Browse button to select the configuration file saved earlier. 

 

Check the Active box, and the system is now configured to automatically download IP 
addresses, software, and configuration files to the terminals. Click on the  box in the 
upper right corner to return to the main menu. 

Note: The software does not need to be authorized now. It can be authorized later, after a 
Telnet session has been established. The procedure is described in the section of 
this chapter entitled Authorizing PowerNet. 
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  Quick Start 

Booting the Terminal 
A warm boot is selected via the Start Menu. 

To perform a cold boot, press and hold the Power button for 15 seconds.  
 

Configuring the Terminal for Download 
The terminal download requires a serial connection between the terminal and the PC 
through a cable. In preparation for this download, connect the cable to the selected serial 
port on the PC and to the terminal. 

On the PC, click on Start, Programs, PowerNet, and Twin Client Manager.  Under the 
Terminal menu, choose Send Program Files to Terminal, as shown in the following 
screen. 

 

The following screen is displayed. 

 

Choose Yes at the prompt. The following screen is displayed. 

 

Click on OK. 

The PC is now configured to download to the terminal. 
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Starting a Telnet Session 
At the Twin Client main menu on the terminal, press any key to establish the connection. 
Until the terminal has been authorized, the following screen is displayed. 
 

RECOVERABLE ERROR 
Terminal not 
Authorized for 
Twin Client 
 
Keypress to Continue… 

It is not necessary to authorize the terminal at this time, so press any key to continue. The 
terminal will establish a connection with the host system and start emulation.  

After a Telnet session has been successfully established, the terminal will remain in 
session for a maximum of 30 minutes at a time until it has been authorized. Once 
authorized, there is no software restriction to the session time. The instructions for 
authorizing the terminal are presented later in Authorizing PowerNet. 

Standard Setup 
The default terminal setup is sufficient for most installations. However, to meet site-
specific requirements, it may be necessary to customize terminal operation. The standard 
setup options simplify this process and can be modified by the following methods: 
• Using the Twin Client Manager. 
• Using the Twin Client terminal menu system. 

To simplify the task for experienced Symbol installers, the standard setup options of both 
the Twin Client Manager and the terminal menu system match those of other Symbol 
products. As an additional conversion aid, customized Symbol configuration files can be 
imported and automatically converted to Twin Client. 

This section describes how to use the Twin Client Manager and the terminal menu system 
to set up the terminal. Also described are the methods for authorizing the terminal 
software. 

Setup Using Twin Client Manager 
The Twin Client Manager provides a Standard Settings tab for automatic setup of the 
terminals. The options within this tab vary according to the emulation selected, each of 
which is described below. Click on Standard under the View option in the main menu. 

VT and HP Settings 
Select the VT and HP emulation setup by clicking on the Settings menu and then the 
Emulation menu, as shown below. 
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  Standard Setup 

 

Then click on the vt100, vt220, or hp700 selection, as shown below. 
 

 

Click on OK after the selection is made, and return to the main Twin Client Manager 
menu. The standard settings tab will now reflect the settings for VT/HP emulation. 
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Terminal Setup 

 
Quadrant Mode  

 
This scrolling list option defines the rules by which the terminal display is positioned in 
the larger host display. As defined by Twin Client, quadrants are fixed position 
"windows" in the host display, and the terminal display is located on whatever quadrant 
contains the current cursor position. 

 Off disables quadrant processing and Twin Client simply centers the current host 
input field in the terminal display.  

 On enables quadrant processing. However, input fields that cross quadrant 
boundaries result in a shift to the left in order to locate as much of the current input 
field on the terminal display.  

 Soft always positions on a quadrant boundary regardless of input field boundaries. 
Viewing keys are enabled. 

 Hard is the same as Soft except the viewing keys are disabled.  

 Lock locks the terminal display origin (upper left corner) to fixed row and column 
(x,y) coordinates in the host display. The coordinates are zero-based.  

Font 
 

Font size has a scrolling list of font size options. Bold Font has a check box that enables 
(checked) or disables (unchecked) the display of characters in bold font. 

Key Click 
 

This check box enables (checked) or disables (unchecked) audible key clicks from the 
terminal. The default value is on (checked). 

Printer Type 
 

This scrolling list selects the attached printer type. The default value is none, indicating 
that no printer is attached. 

5250 Settings 
Select the 5250 emulation setup by clicking on the Settings menu and then the 
Emulation menu, as shown below. 
 

 

Then click on the 5250 selection, as shown below. 
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  Standard Setup 

 

Click on OK after the selection is made, and return to the main Twin Client Manager 
menu. The standard settings tab will now reflect the settings for 5250 emulation. 
 

 

 
Quadrant Mode  
 

This scrolling list option defines the rules by which the terminal display is positioned in 
the larger host display. As defined by Twin Client, quadrants are fixed position 
"windows" in the host display, and the terminal display is located on whatever quadrant 
contains the current cursor position. 

 Off disables quadrant processing and Twin Client simply centers the current host 
input field in the terminal display.  
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 On enables quadrant processing. However, input fields that cross quadrant 
boundaries result in a shift to the left in order to locate as much of the current input 
field on the terminal display.  

 Soft always positions on a quadrant boundary regardless of input field boundaries. 
Viewing keys are enabled. 

 Hard is the same as Soft except the viewing keys are disabled.  

 Lock locks the terminal display origin (upper left corner) to fixed row and column 
(x,y) coordinates in the host display. The coordinates are zero-based.  

Font 
 

Font size has a scrolling list of font size options. Bold Font has a check box that enables 
(checked) or disables (unchecked) the display of characters in bold font. 

Key Click 
 

This check box enables (checked) or disables (unchecked) audible key clicks from the 
terminal. The default value is on (checked). 

Printer Type 
 

This scrolling list selects the attached printer type. The default value is none, indicating 
that no printer is attached. 

3270 Settings 
Select the 3270 emulation setup by clicking on the Settings menu and then the 
Emulation menu, as shown below. 
 

 

Then click on the 3270 selection, as shown below. 
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  Standard Setup 

 

Click on OK after the selection is made, and return to the main Twin Client Manager 
menu. The standard settings tab will now reflect the settings for 3270 emulation. 
 

 

Quadrant Mode  
 

This scrolling list option defines the rules by which the terminal display is positioned in 
the larger host display. As defined by Twin Client, quadrants are fixed position 
"windows" in the host display, and the terminal display is located on whatever quadrant 
contains the current cursor position. 

 Off disables quadrant processing and Twin Client simply centers the current host 
input field in the terminal display.  

Supported Equipment Manual   •   June, 2006    2-19



Terminal Setup 

 On enables quadrant processing. However, input fields that cross quadrant 
boundaries result in a shift to the left in order to locate as much of the current input 
field on the terminal display.  

 Soft always positions on a quadrant boundary regardless of input field boundaries. 
Viewing keys are enabled. 

 Hard is the same as Soft except the viewing keys are disabled.  

 Lock locks the terminal display origin (upper left corner) to fixed row and column 
(x,y) coordinates in the host display. The coordinates are zero-based.  

Font 
 

Font size has a scrolling list of font size options. Bold Font has a check box that enables 
(checked) or disables (unchecked) the display of characters in bold font. 

Key Click 
 

This check box enables (checked) or disables (unchecked) audible key clicks from the 
terminal. The default value is on (checked). 

Printer Type 
 

This scrolling list selects the attached printer type. The default value is none, indicating 
that no printer is attached. 

Importing Custom Configurations 
Existing installations that use a custom Symbol configuration file are easily converted to 
Twin Client with the Import option found under the File tab of Twin Client Manager. 
 

 

Click on Import, and if necessary then click on the Browse button to locate the file. 
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  Standard Setup 

To further simplify conversion, the import utility displays all conversion errors and 
warnings so that potential compatibility problems can be easily identified and corrected. 

Importing ROI configuration files works with Wavelink in release 7 or earlier, provided 
that the Wavelink client is using the term.cfg file. 

Terminal Setup Using Twin Client Menus 
The Twin Client terminal software provides an internal menu system for configuring 
certain parameters on the terminal and for switching between Server and Telnet modes of 
operation.  To access this menu system, press uppercase C at the startup screen. 
 

Twin Client 
© 1991-2006, Connect, Inc. 
 
Keypress to Continue 
 
Note: The date of 2006 is updated on the terminal at the time of a new release. 
 
The following menu appears in thick (Telnet) mode: 
  
Edit Server/Host IPs 
Edit License Key 
Switch Client Modes 
Run Client Emulator 
Exit to OS 
  
The following menu appears in thin (Server) mode: 
  
Edit Server/Host IPs 
Run Site Survey 
Switch Client Modes 
Run Client Emulator 
Exit to OS 

Use the Up-Arrow and Down-Arrow keys to navigate the menu, and press Enter to select 
the highlighted option. Each menu option is described below. 

Edit Server/Host IPs 

If the host IP address(es) were not pre-configured as described in the Setting the Servers 
section of Configuring the Manager, or if you wish to change those settings using the 
terminal menus, select this option and enter up to four Host IP addresses as required. 
 

     Host 0 
IP 206.183.67.155 
Port 23__ 
 
<F3> Save <F7> Quit 
 
Press F3 to save the configurations. 
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Edit License Key 

The client software can be authorized automatically, as described in the next section, 
Authorizing PowerNet. This menu option permits authorization of each terminal 
manually. Select this option to obtain the terminal's Identification Code, which is used to 
obtain the Authorization code from the Connect web site, as described in the next section. 

The 12-digit value displayed at the top of the terminal screen is the Identification Code 
for the terminal. 
 

00A0F826E614 
Authorization 
  ______________ 
not authorized 
 
<F3> Save <F7> Quit 

Type the Authorization code into the field as it appears on the web site. Punctuation 
characters, such as the hyphen (-), are required. Press F3 to save the Authorization code. 

Run Site Survey 

This option (a feature of Spectrum 1) is applicable to Release 5.0 and may be obsolete for 
your terminal. 

Switch Client Modes 

The PowerNet Twin Client normally operates in Telnet mode, which provides direct 
connection to Telnet hosts. It can also operate in Server mode, through a PowerNet 
OpenAir server. Select this menu option to switch between Server and Telnet modes of 
operation. Note that the host socket address for the PowerNet OpenAir servers is 1800, 
which must also be changed in the Edit Server/Host IPs menu described above. 

Run Client Emulator 

After all desired changes have been made, select this option to return to the Twin Client 
main menu. Then press any key to establish the Telnet session and begin emulation. 
Refer to Starting a Telnet Session for further instructions. 
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Authorizing PowerNet 
 
Each PowerNet Twin Client will run for 30 minutes at a time without authorization.  
Uninterrupted operation for a production environment is the result of authorizing the 
software.  

The Twin Client Manager can automatically authorize the terminal over the wireless 
network if the following requirements are met: 
• A PC running Twin Client Manager is connected to the wire LAN segment with at 

least one access point within range of the terminal. 
• The Airload Hex file is installed on the terminal. 
• The System ID of the PC on which Twin Client Manager is installed has been used to 

obtain a site license Authorization code from the Connect web site. 

To obtain the System ID of the Twin Client Manager, click on the Authorization option 
in the Tools menu, as shown below. 
 

 

The Authorization window is displayed as shown below. 
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Your System ID appears in the first box of the screen.  

 
Go to http://www.connectrf.com. Click on Partner Services. Click on the Generate 
Authorization icon at the top of the page. Follow the directions on the web site. 

Authorized Terminals 
The number of terminals authorized, the number of terminals in use, and the number of 
terminals remaining is provided in the Authorized Terminals box on the lower left side of 
the screen. 

Click on the Details button to number the options in the screen below in the order of your 
priority. 

Note: The terminal may or may not be able to utilize the Formatter feature depending on 
its Authorization codes. 
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Click on an option and move it using the Up and Down buttons.  

Click on OK when finished. 

The Manual Authorization button is an alternate method of obtaining an Authorization 
code for a terminal. This method does not utilize Airloader, as does the other method. 

Click on this button, manually enter your MAC address in the screen that appears, and 
click on OK. This enables you to generate individual Authorization codes.  

Add Licenses 
The Add Licenses feature is used when adding additional licenses to an already site 
licensed Twin Client Manager.  

An example of this is the instance in which Twin Client Manager is licensed for 10 
licenses, and the customer purchases another 10 licenses to make a total of 20 licenses. 

From Twin Client Manager, choose Authorization from under the Tools menu.  

Click on the Add Licenses button. 
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A pop-up box appears with the Machine ID and a space for the additional license’s 
Authorization code.   

 

Enter the additional license’s Authorization code and click on OK. 

Use the Machine ID in the pop-up box instead of the original Machine ID to get your 
Authorization code.   

If adding users, click on the Add Licenses button before generating the Authorization 
code to get the most current Machine ID. 
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Transfer Authorization 
 
The Transfer Authorization feature is used when moving a site license from one PC to 
another.   
 
After Twin Client Manager is installed on a new PC, you will need the System/Machine 
ID for it.  This ID appears in the first box of the Authorization screen. 
 
From Twin Client Manager, select Authorization from under the Tools menu. 

 
Click on the Transfer Authorization button on the old PC.  
 
You will be asked for the new System ID.  Enter this new System ID.  It will generate an 
Authorization code for the new PC's Twin Client Manager.  

 

 
 
 

Note: This feature only works if there are licenses remaining on the old PC.   
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Listing 
Click on the Listing button to view Authorization codes issued.  

The Authorization codes used along with their corresponding serial numbers will appear. 

 
 
Click on OK when finished. 
 
Click on the Close button when finished. 
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Software Management 
In addition to providing functions for the download of files to the terminal via the 
traditional serial connection, the Twin Client Manager also provides for the management 
of terminal software and configurations automatically over the wireless network. This 
section describes the automated capability in detail.  

Airloader Auto-Configuration 
The software and supporting configuration files for all Twin Client terminals can be 
configured for automated management after installing the Twin Client AirLoad Hex file 
in the terminals, as described in the section entitled Quick Start. The Airloader Auto-
Configuration form is accessed from the Twin Client Manager Tools menu. Select 
Airloader. 

 
Note: If no options are displayed, click on the Advanced<< button. 

Enabling Automatic Downloads 

Click to put a check in the box that allows terminals to be automatically configured via 
RF to enable automatic downloading. In the event that another PC on the network is 
already configured and active, the following warning message is displayed. 
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Synchronizing Configuration Files 

Click to put a check in the Synchronize Configuration Files box to enable automatic 
synchronization of configuration files on the terminal. When the terminal is cold booted, 
its configuration files will be compared with the most recent on the PC. The terminal is 
updated automatically if it does not have the latest revision. 

Synchronizing Program Files 

Click to put a check in the Synchronize Program Files box to enable automatic 
synchronization of program files on the terminal. When the terminal is cold booted, its 
program files will be compared with the most recent on the PC. The terminal is updated 
automatically if it does not have the latest revision. 

Automatic IP Address Assignment 

An IP address does not need to be assigned to the terminal. The terminal can find the 
airloader server automatically. 

Creating New Groups 

New groups, with different configurations, can be created by clicking on 
Terminal/Group Manager and then clicking the right mouse button as shown. 

 

After the new group has been created, the group settings option becomes available for 
change, as shown below. 
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After the Configuration File and all of the other parameters have been set, the group is 
made active by clicking in the Active check box. 

Note: A setting under the Group allows you to associate a saved server file (.svr file) 
with a particular group.  This means that the .svr file will be sent to the terminal in 
place of the default power.net file. The .svr files are created in Twin Client 
Manager under Tools/Servers. 
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Clicking on the Thin Mode button will cause all terminals in this group that are currently 
running in thick mode to be switched to thin mode the next time Airloader is run on the 
terminal. 
 
Click on the Schedule button to view a dialog box for scheduling an automatic Airloader 
update. 

 

 

Select the desired time and click on OK. Click on Update Now to check all group 
members for updates. 
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Setting the Segment 

Checking the Segment button restricts a terminal group to a range of IP addresses. The 
IP Address can be any valid address on the segment as it is used only to identify the 
segment. The setting of the Net Mask can be used to restrict the range.  This feature is 
useful for segregating terminal groups by location. 

Setting Force Reload 

Clicking on the Force Reload button forces all terminals within a group to be 
automatically updated. The following warning message appears: 

 

Click on the Yes button to force the reload. 

Setting the Default Terminal Group 

New terminals that have not yet been assigned to any group are initially assigned to the 
default group in effect when they are cold-booted. 

 

Any group can be made the default group by clicking on the group, and then clicking on 
the right mouse button. Then click on the Make Default option. 

Reassigning Terminals 

After a terminal has been configured and assigned to the default group, it can be 
reassigned to a new group by clicking on the terminal icon as shown below. 
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Then, holding the mouse button down, drag the terminal icon to the desired group as 
shown next. 

 

Release the mouse button, which reassigns the terminal. 

 

The next time the terminal is rebooted, it will be reconfigured as defined in the group 
specification. 

Mobile Device Manager (MDM) Features 
 
Under Tools in Twin Client Manager are the Screen Watcher, Terminal Messenger, and 
RF Monitor features. 
 
Note: The terminal may or may not be able to utilize the Screen Watcher or Terminal 

Messenger features depending on its Authorization codes.  
 

 
 

Select Screen Watcher, enter the terminal’s IP address, and click on OK. 
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A screen will appear with a display resembling the terminal screen. 
 

 
 

Clicking on the Font button on the upper left brings up a screen in which you can modify 
the font settings, as shown below. 
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Select Terminal Messenger from the Tools menu.  
 
You may enter an Address Range in the From and To boxes on this screen. Click on Add 
when finished. 
 
Enter a message to send in the space provided, select the terminal to receive this message 
by clicking on it in the Select Terminal(s) column, and click on the Send button to send 
the message of your choice to the terminal of your choice. 
 
See the example of the Terminal Messenger screen below. 
 

 
 

To remove a terminal from the list of terminals receiving your message, click on the 
terminal number in the Select Terminal(s) column, and click on the Remove button. 
Click on the appropriate button, Remove All, Select All, or Unselect All, to remove all 
terminals, select all terminals, or unselect all terminals from the Select Terminal(s) list. 
 
Note: Use the Ctrl and Shift keys to select multiple terminals. 
 
Click on the Close button when finished. 
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MDM’s Find and Identify Features 

The Find feature enables the network manager to remotely turn a terminal on and cause it 
to make an audible beep so that the terminal can be heard and located within the facility.  
The configurable Identify feature enables you to track the last user of a hand held 
terminal.  The operator’s logging a password when a terminal session is started enables 
the network manager to know who last used the device in the event that it is lost. 

To cause the terminal to make audible beeps so that it can be located, enter the IP 
address(s) of the terminal, highlight to select, and click on the Ping button. 
 

 
 
The TnPing screen will appear. When the terminal is located, it will beep continuously 
until the user presses any key on the terminal. 

 

 
 

Click on Close. 
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To identify the person using the terminal, check Request Login Information.  
 

 
 
Then from the main menu, select Terminal, and Send Configuration Files to Terminal.  
 

On the terminal, enter the user’s name:  
 
  
 
 
 
 
The username must be 6 characters long. Press Enter. Log in to the host as always. 
 
Return to the Terminal Messenger screen, select the IP address, and click on Ping. This 
requests the login information from the terminal. The login information is saved on the 
PC in the PowerNet Twin Client directory in a file called login.txt. A sample of the file 
appears as follows: 
 
                       11:25:16:   04-15-05,    207.241.78.248,    12345 
 
 
                            time         date             IP address      last login on 
                                                                of terminal      the terminal 
 
 
 

Username:
_ _ _ _ _ _ 
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Select RF Monitor from the Tools menu. 
 

 
 

RF Monitor is an "Over The Air" diagnostic tool. It is used to collect diagnostic trace 
information from RF terminals running PowerNet Twin Client software. 

It runs on a Windows PC and will send a command to the RF terminal to start tracing. 
The terminal, when it receives this command, will start sending the trace information 
over the RF link to the PC that issued the command. This will be written to a file on this 
PC that can be sent to us for analysis. 

Click on File to Select Terminal or to Exit. 

 

Choosing Select Terminal allows you to view a log of the terminal’s activity. Enter the 
Terminal IP address and Terminal IP Port, and click on OK.  
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Click on Edit. Select Find, and/or Find Next to search for pieces of information in your 
log, or select Clear to clear the search. 

 

Click on Actions to select Start Monitor or Stop Monitor. 

 

Click on Tools to choose Set Debug Levels or Settings. 

 

The options in Set Debug Levels are shown below. 
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To select a TCP connection (a UDP connection is the default), position the terminal at the 
following prompt. 

TwinClient 
(c) 1991-2006 Connect 
Keypress To Continue 

 
On the PC, choose Tools and then choose Settings. 

        
Click on the TCP radio button in the window that appears. The maximum log file size 
can also be set here. 
           

 
 

Click on the OK button. 
 

Then click on the green button in RF Monitor, as shown below (the second button from 
the left, under the File, Edit, Actions… menu). 
 

 
  
Press Enter on terminal. 
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Click on View to show or hide the Toolbar and the Status Bar.  

 

This is the Toolbar. It is found near the top of the screen. 

 

This is the Status Bar. It is found at the bottom of the screen. 

 

Click on About RF Monitor under Help to view version number information. Click on  
About Twin Client Manager under Help in the main menu to view the following screen. 

 

RF Monitor is a very small program and does not even require installation. Just place it in 
a directory on your PC and create a shortcut to run it. It will run on all versions of 
Windows except V3.1 and Windows 95.  

 
1. Move RF Monitor to a Windows PC with Network access to the RF terminal. 
 
2. Run RF Monitor. (Create a shortcut or do a Start/Run.) 
 
3. From the pull down menu, select File/Select Terminal. 
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4. Key in the RF terminal IP address and leave the port at 1802. 
 

 
 

5. From the pull down menu, select Tools/Set Debug Levels. Set all levels to 9 except 
Datastream and SNA. 

 

 
  

6. With the RF terminal sitting at the Press Any Key prompt, select Actions/Start 
Monitor. 

 
7. Press a key on the RF terminal to open a session, and you should see trace data in the 

RF Monitor window. When done, end the trace and the file will be named 
tnxxx.yyy.log (where xxx.yyy is the last 2 octets of the RF terminal’s IP address) in 
the directory in which RF Monitor was running. 

 

Supported Equipment Manual   •   June, 2006    2-43



Terminal Setup 

 

Common Problems with RF Monitor 
 

• The trace won’t start.  

RF Monitor uses UDP to send commands to the RF device. On busy networks UDP 
packets are not always delivered. The terminal can miss the command to start the 
trace. Below are some things that can be useful. 
 
a.   Ping the RF terminal from the PC used before starting RF Monitor. (This seems 

to "open" a path to the terminal). 

b.   Start the monitor with the terminal at the Press Any Key prompt. (While the 
terminal is at this prompt, it is not doing much and has a better chance of hearing 
the start trace command.) 

 
• I don't understand what this trace means. 

 
The trace that this tool collects is engineering level information. It allows an end user 
to collect information that can be analyzed by Connect engineering. 
 
It will generally be requested by Connect support to help diagnose a reported 
problem. 
 
To be able to read and understand these completely, you need to have an 
understanding of: 

 

  Supported Equipment Manual    •   June, 2006 2-44



  Software Management 

a.  Emulation protocols (IBM 5250, IBM 3270, DEC VT200, etc.) 
b.  PowerNet Twin Client products 
c.  RF network concepts 
d.  Wired network concepts 
e.  Telnet sessions 
f.   TCP/IP  

 

They are text files that can be read with any editor or viewer and can be useful to end 
users and integrators even if they may not have all the requirements above. 
 

• I have an intermittent problem and it could happen on any one of my 100 
terminals. RF Monitor only does one terminal at a time. What can I do? 

RF Monitor is not the right diagnostic tool for this type of problem. PowerNet 
products have another diagnostic tool that can be used called the "Diagnostic Server".  
 
This tool can be set up to run trace diagnostics on up to 300 terminals at the same time. 
This tool will be provided as needed for systems under PowerNet support agreement 
OR by T&M when they are not covered. 

It also includes the service of a PowerNet support engineer. 

 
Server Transfer is another feature.  From the Tools menu, select Server Transfer. 

 
The FTP Settings screen appears. 

 
 
To send object editor and configuration files from Windows to your Linux box, enter 
your server address, and click on OK. 
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Sending Program and Configuration Files to the 
Terminal 
 

 
1.   Boot the terminal.  

2.   On the PC, select Send Program Files to Terminal from the Terminal menu in Twin 
Client Manager. 

 

The following screen will appear. 

 

 
   3.  Click on OK. 

The following screen will appear. 

 

 
4.   Click on OK. 

 
5.  On the PC, choose Send Configuration Files to Terminal from the Terminal menu 

in Twin Client Manager. 
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You will see the following screen. 
 

 
 

6.   Choose Yes. 
 

 
 

7.   Click on OK. 
 

The following screen will appear. 
 

 
 
 

8. Click on OK. 
 

9. Warm boot the terminal. 
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Chapter 3 • Keypad Configuration 

38-key Diagrams 
The 38-key diagrams begin on the following page. 
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38-key Table 
 
Key VT/HP 3270 5250 
a *<A> <Shift>*<A> <Shift>*<A> 
b *<B> <Shift>*<B> <Shift>*<B> 
c *<C> <Shift>*<C> <Shift>*<C> 
d *<D> <Shift>*<D> <Shift>*<D> 
e *<E> <Shift>*<E> <Shift>*<E> 
f *<F> <Shift>*<F> <Shift>*<F> 
g *<G> <Shift>*<G> <Shift>*<G> 
h *<H> <Shift>*<H> <Shift>*<H> 
i *<I> <Shift>*<I> <Shift>*<I> 
j *<J> <Shift>*<J> <Shift>*<J> 
k *<K> <Shift>*<K> <Shift>*<K> 
l *<L> <Shift>*<L> <Shift>*<L> 
m *<M> <Shift>*<M> <Shift>*<M> 
n *<N> <Shift>*<N> <Shift>*<N> 
o *<O> <Shift>*<O> <Shift>*<O> 
p *<P> <Shift>*<P> <Shift>*<P> 
q *<Q> <Shift>*<Q> <Shift>*<Q> 
r *<R> <Shift>*<R> <Shift>*<R> 
s *<S> <Shift>*<S> <Shift>*<S> 
t *<T> <Shift>*<T> <Shift>*<T> 
u *<U> <Shift>*<U> <Shift>*<U> 
v *<V> <Shift>*<V> <Shift>*<V> 
w *<W> <Shift>*<W> <Shift>*<W> 
x *<X> <Shift>*<X> <Shift>*<X> 
y *<Y> <Shift>*<Y> <Shift>*<Y> 
z *<Z> <Shift>*<Z> <Shift>*<Z> 
A <Shift>*<A> *<A> *<A> 
B <Shift>*<B> *<B> *<B> 
C <Shift>*<C> *<C> *<C> 
D <Shift>*<D> *<D> *<D> 
E <Shift>*<E> *<E> *<E> 
F <Shift>*<F> *<F> *<F> 
G <Shift>*<G> *<G> *<G> 
H <Shift>*<H> *<H> *<H> 
I <Shift>*<I> *<I> *<I> 
J <Shift>*<J> *<J> *<J> 
K <Shift>*<K> *<K> *<K> 
L <Shift>*<L> *<L> *<L> 
M <Shift>*<M> *<M> *<M> 
N <Shift>*<N> *<N> *<N> 
O <Shift>*<O> *<O> *<O> 
P <Shift>*<P> *<P> *<P> 
Q <Shift>*<Q> *<Q> *<Q> 
R <Shift>*<R> *<R> *<R> 
S <Shift>*<S> *<S> *<S> 
T <Shift>*<T> *<T> *<T> 
U <Shift>*<U> *<U> *<U> 
V <Shift>*<V> *<V> *<V> 
W <Shift>*<W> *<W> *<W> 
X <Shift>*<X> *<X> *<X> 
Y <Shift>*<Y> *<Y> *<Y> 
Z <Shift>*<Z> *<Z> *<Z> 
1 <1> <1> <1> 
2 <2> <2> <2> 
3 <3> <3> <3> 
4 <4> <4> <4> 
5 <5> <5> <5> 
6 <6> <6> <6> 
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7 <7> <7> <7> 
8 <8> <8> <8> 
9 <9> <9> <9> 
0 <0> <0> <0> 
F1 --- <F1> <F1> 
F2 --- <F2> <F2> 
F3 --- <F3> <F3> 
F4 --- <F4> <F4> 
F5 --- <F5> <F5> 
F6 --- <F6> <F6> 
F7 --- <F7> <F7> 
F8 --- <F8> <F8> 
F9 --- <F9> <F9> 
F10 --- <F10> <F10> 
F11 --- <Shift><F1> <Shift><F1> 
F12 --- <Shift><F2> <Shift><F2> 
F13 --- <Shift><F3> <Shift><F3> 
F14 --- <Shift><F4> <Shift><F4> 
F15 --- <Shift><F5> <Shift><F5> 
F16 --- <Shift><F6> <Shift><F6> 
F17 --- <Shift><F7> <Shift><F7> 
F18 --- <Shift><F8> <Shift><F8> 
F19 --- <Shift><F9> <Shift><F9> 
F20 --- <Shift><F10> <Shift><F10> 
F21 --- <Ctrl><F1> <Ctrl><F1> 
F22 --- <Ctrl><F2> <Ctrl><F2> 
F23 --- <Ctrl><F3> <Ctrl><F3> 
F24 --- <Ctrl><F4> <Ctrl><F4> 
▲ --- <▲> <▲> 
▼ --- <▼> <▼> 
◄ --- <◄> <◄> 
► --- <►> <►> 
Alpha <Alpha> <Alpha> <Alpha> 
Backlight <Backlight> <Backlight> <Backlight> 
Backspace <Bksp> <Bksp> <Bksp> 
Backtab <Shift><Func><►> <Shift><Func><►> <Shift><Func><►> 
Ctrl <Ctrl> <Ctrl> <Ctrl> 
Enter (Send in 5250) --- <Ent> <Ctrl><Ent> 
Esc <Esc> --- --- 
Func <Func> <Func> <Func> 
Green <Green> <Green> <Green> 
Power <Power> <Power> <Power> 
Red <Red> <Red> <Red> 
Shift <Shift> <Shift> <Shift> 
Space *<Bksp> *<Bksp> *<Bksp> 
Tab <Func><►> <Func><►> <Func><►> 
.   period <.> <.> <.> 
,   comma <,> <,> <,> 
‘   apostrophe <Func><1> <Func><1> <Func><1> 
`   grave accent <Func><2> <Func><2> <Func><2> 
\   backslash <Func><3> <Func><3> <Func><3> 
[   left bracket <Func><4> <Func><4> <Func><4> 
]   right bracket <Func><5> <Func><5> <Func><5> 
;   semicolon <Func><6> <Func><6> <Func><6> 
-   hyphen <Func><7> <Func><7> <Func><7> 
=  equal sign <Func><8> <Func><8> <Func><8> 
/   forward slash <Func><9> <Func><9> <Func><9> 
!   exclamation <Shift><1> <Shift><1> <Shift><1> 
@ at sign  <Shift><2> <Shift><2> <Shift><2> 
#  pound <Shift><3> <Shift><3> <Shift><3> 
$  dollar <Shift><4> <Shift><4> <Shift><4> 
% percent <Shift><5> <Shift><5> <Shift><5> 
^  carat <Shift><6> <Shift><6> <Shift><6> 
& ampersand <Shift><7> <Shift><7> <Shift><7> 
*   asterisk <Shift><8> <Shift><8> <Shift><8> 
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(   left parenthesis <Shift><9> <Shift><9> <Shift><9> 
)   right parenthesis <Shift><0> <Shift><0> <Shift><0> 
<  less than <Shift><,> <Shift><,> <Shift><,> 
>  greater than <Shift><.> <Shift><.> <Shift><.> 
“  quotes <Shift><Func><1> <Shift><Func><1> <Shift><Func><1> 
~  tilde <Shift><Func><2> <Shift><Func><2> <Shift><Func><2> 
|   vertical bar <Shift><Func><3> <Shift><Func><3> <Shift><Func><3> 
{   left brace <Shift><Func><4> <Shift><Func><4> <Shift><Func><4> 
}   right brace <Shift><Func><5> <Shift><Func><5> <Shift><Func><5> 
:   colon <Shift><Func><6> <Shift><Func><6> <Shift><Func><6> 
_  underscore <Shift><Func><7> <Shift><Func><7> <Shift><Func><7> 
+  addition <Shift><Func><8> <Shift><Func><8> <Shift><Func><8> 
?  question <Shift><Func><9> <Shift><Func><9> <Shift><Func><9> 
Attention --- <Ctrl><7> <Ctrl><7> 
Clear --- <Esc> <Func><Ctrl><Bksp> 
Delete --- <Ctrl><Bksp> <Ctrl><Bksp> 
Dup --- <Ctrl><2> <Ctrl><2> 
Clear EOF --- <Ctrl><0> --- 
Erinp --- <Ctrl><1> <Ctrl><1> 
Field exit --- --- <Ent> 
Field minus --- --- <Ctrl>*<F> 
FM --- <Ctrl>*<F> --- 
Help --- --- <Ctrl><4> 
Home --- <Ctrl><8> <Ctrl><8> 
Insert --- <Ctrl><9> <Ctrl><9> 
Newline --- <Ctrl>*<P> --- 
Pa1 --- <Ctrl><F5> --- 
Pa2 --- <Ctrl><F6> --- 
Pa3 --- <Ctrl><F7> --- 
Print --- --- <Ctrl><.> 
Reset --- <Ctrl><,> <Ctrl><,> 
Roll up --- --- <Ctrl><6> 
Roll down  --- --- <Ctrl><3> 
Sys req --- <Ctrl><5> <Ctrl><5> 
Program information <Func><Ctrl>*<P> <Func><Ctrl>*<P> <Func><Ctrl>*<P> 
Diagnostics <Func><Ctrl>*<D> <Func><Ctrl>*<D> <Func><Ctrl>*<D> 
Keyclicks on/off <Func><Ctrl>*<K> <Func><Ctrl>*<K> <Func><Ctrl>*<K> 
Quiet mode on/off <Func><Ctrl>*<Q> <Func><Ctrl>*<Q> <Func><Ctrl>*<Q> 
Terminal configuration <Func><Ctrl>*<C> <Func><Ctrl>*<C> <Func><Ctrl>*<C> 
Host profiles <Func><Ctrl>*<R> <Func><Ctrl>*<R> <Func><Ctrl>*<R> 
Message recall --- <Func><Ctrl>*<M> <Func><Ctrl>*<M> 
Free cursor mode --- <Func><Ctrl>*<F> <Func><Ctrl>*<F> 
Close session <Func><Ctrl>*<T> <Func><Ctrl>*<T> <Func><Ctrl>*<T> 
Previous session <Ctrl><F9> <Ctrl><F9> <Ctrl><F9> 
Next session <Ctrl><F10> <Ctrl><F10> <Ctrl><F10> 
View mode on/off <Func><Ctrl>*<Z> <Func><Ctrl>*<Z> <Func><Ctrl>*<Z> 
Scroll up --- <Ctrl><▲> <Ctrl><▲> 
Scroll down --- <Ctrl><▼> <Ctrl><▼> 
Scroll left --- <Ctrl><◄> <Ctrl><◄> 
Scroll right --- <Ctrl><►> <Ctrl><►> 
View up <Shift><▲> <Shift><▲> <Shift><▲> 
View down <Shift><▼> <Shift><▼> <Shift><▼> 
View left <Shift><◄> <Shift><◄> <Shift><◄> 
View right <Shift><►> <Shift><►> <Shift><►> 
^@ <Ctrl><2> --- --- 
^A <Ctrl>*<A> --- --- 
^B <Ctrl>*<B> --- --- 
^C <Ctrl>*<C> --- --- 
^D <Ctrl>*<D> --- --- 
^E <Ctrl>*<E> --- --- 
^F <Ctrl>*<F> --- --- 
^G <Ctrl>*<G> --- --- 
^H <Ctrl>*<H> --- --- 
^I <Ctrl>*<I> --- --- 
^J <Ctrl>*<J> --- --- 
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  38-key Table 

^K <Ctrl>*<K> --- --- 
^L <Ctrl>*<L> --- --- 
^M <Ctrl>*<M> --- --- 
^N <Ctrl>*<N> --- --- 
^O <Ctrl>*<O> --- --- 
^P <Ctrl>*<P> --- --- 
^Q <Ctrl>*<Q> --- --- 
^R <Ctrl>*<R> --- --- 
^S <Ctrl>*<S> --- --- 
^T <Ctrl>*<T> --- --- 
^U <Ctrl>*<U> --- --- 
^V <Ctrl>*<V> --- --- 
^W <Ctrl>*<W> --- --- 
^X <Ctrl>*<X> --- --- 
^Y <Ctrl>*<Y> --- --- 
^Z <Ctrl>*<Z> --- --- 
*Alpha mode 
 
VT100 emulation 
Backspace <Bksp> 
Backspace (delete) <Ctrl><Bksp> 
Backtab <Shift><Func><►> 
BS <Bksp> 
Enter <Ent> 
Esc <Esc> 
Hard terminal reset <Func><Ctrl>*<H> 
LF <Ctrl><Ent> 
PF1 <F1> 
PF2 <F2> 
PF3 <F3> 
PF4 <F4> 
Return  <Ent> 
Tab <Func><►> 
▲ <▲> 
▼ <▼> 
◄ <◄> 
► <►> 
*Alpha mode 
 
VT220 emulation 
Backspace <Bksp> 
Backspace (delete) <Ctrl><Bksp> 
Backtab <Shift><Func><►> 
Enter <Ent> 
Find <Ctrl><8> 
Hard terminal reset <Func><Ctrl>*<H> 
Insert <Ctrl><9> 
Next screen <Ctrl><3> 
Prev screen <Ctrl><6> 
Remove <Shift><Bksp> 
Return  <Ent> 
Select <Ctrl><2> 
Soft terminal reset <Func><Ctrl>*<S> 
Tab <Func><►> 
PF1 <F1> 
PF2 <F2> 
PF3 <F3> 
PF4 <F4> 
Break (key not available) <F5> 
F6 <F6> 
F7 <F7> 
F8 <F8> 
F9 <F9> 
F10 <F10> 
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Keypad Configuration 

F11 <Shift><F1> 
F12 <Shift><F2> 
F13 <Shift><F3> 
F14 <Shift><F4> 
F15 (Help) <Shift><F5> 
F16 (Do) <Shift><F6> 
F17 <Shift><F7> 
F18 <Shift><F8> 
F19 <Shift><F9> 
F20 <Shift><F10> 
▲ <▲> 
▼ <▼> 
◄ <◄> 
► <►> 
*Alpha mode 
 
HP emulation 
Backspace <Bksp> 
Backspace (delete) <Ctrl><Bksp> 
Backtab <Shift><Func><►> 
Clear line <Shift><F3> 
Clear display <Shift><F4> 
Delete char <Ctrl><2> 
Delete char with wrap <Shift><F6> 
Delete line <Ctrl><8> 
Enter <Ent> 
F1 <F1> 
F2 <F2> 
F3 <F3> 
F4 <F4> 
F5 <F5> 
F6 <F6> 
F7 <F7> 
F8 <F8> 
Hard terminal reset <Ctrl><.> 
Insert char <Shift><Bksp> 
Insert char with wrap <Shift><F5> 
Insert line <Ctrl><9> 
Next <Ctrl><3> 
Prev <Ctrl><6> 
Return <Ent> 
Scroll down <Shift><F7> 
Scroll up <Shift><F8> 
Soft terminal reset <Func><Ctrl>*<S> 
System Modes Menu <Shift><F10> 
Tab <Func><►> 
User Key Menu <F10> 
▲ <▲> 
▼ <▼> 
◄ <◄> 
► <►> 
*Alpha mode 
 
Note: The Alpha key is orange. The Func key is blue. 
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Chapter 4 • Error Message Resolution Guide 
Twin Client Error Message Resolution Guide 

 
Message Reason Solution Reference Tech Note 

ENTRY TOO LONG; Trying to key beyond the field size. Ensure that you are entering input into the 
correct field. 

--- 

ALPHABETIC ONLY; Trying to key a character that is not 
alphabetic. 

Ensure that you are entering input into the 
correct field. 

--- 

MINUS NOT VALID; Trying to key a Minus sign. Ensure that you are entering input into the 
correct field. 

--- 

DECIMAL NOT VALID; Trying to key a Decimal (period). Ensure that you are entering input into the 
correct field. 

--- 

ALPHANUMERIC ONLY; Trying to key characters other than 
Alphabetic and numeric. 

Ensure that you are entering input into the 
correct field. 

--- 

NUMERIC ONLY; Trying to key characters other than 
numeric. 

Ensure that you are entering input into the 
correct field. 

--- 

ENTRY TOO SHORT; Trying to exit the field before it is 
filled. 

Ensure that you are entering input into the 
correct field. 

--- 

Supported Equipment Manual    •   June, 2006    4-1



Error Message Resolution Guide 

 

Message Reason Solution Reference Tech Note 
    

INVALID KEY; The key pressed is not valid. Ensure that you are entering input into the 
correct field. 

--- 

MUST CLEAR FIELD; Trying to enter data in a field that 
must be cleared first. 

Ensure that you are entering input into the 
correct field. 

--- 

SCAN NOT ALLOWED; Trying to scan into a key only field. Ensure that you are entering input into the 
correct field. 

--- 

KEY NOT ALLOWED; Trying to key into a scan only field. Ensure that you are entering input into the 
correct field. 

--- 

ENTRY TOO SHORT; Trying to exit the field before it is 
filled. 

Ensure that you are entering input into the 
correct field. 

--- 

RECOVERABLE ERROR; Encountered an error from which 
you can continue. 

Verify that your configuration settings for the 
hardware being used, usually a printer and 
cable issue. 

--- 

UNRECOVERABLE ERROR; Encountered an error from which 
you can NOT continue. 

Verify that your Network settings are correct 
and you are in the correct mode using the 
correct Port. 
 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

FUNCTION: \n\nFILE: \nLINE: \nCODE; Encountered an error from which 
you can NOT continue. 

Notify Connect over the Web incident 
reporting system. 

--- 

Press any key\nFor More Details...; Press Enter for more information. Advisory message. --- 

Press any key; Press a key to continue. Advisory message. --- 
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Connection ERROR.\nREBOOT 
MOBILE UNIT; 

Could not Connect. Verify that your Network settings are correct 
and you are in the correct mode using the 
correct Port. 
 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Disconnect ERROR.\nREBOOT 
MOBILE UNIT; 

Could not Disconnect. Verify that your Network settings are correct 
and you are in the correct mode using the 
correct Port. 
 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

RF Send ERROR.\nREBOOT MOBILE 
UNIT; 

Could not Send. Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

RF Receive ERROR.\nREBOOT 
MOBILE UNIT; 

Could not Receive. Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

RF Check ERROR.\nREBOOT 
MOBILE UNIT; 

Could not run the RF Survey. Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

RF Timeout ERROR.\nREBOOT 
MOBILE UNIT; 

Have been trying to contact the 
host for the radio timeout period (2 
minutes default). 

Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

REBOOT MOBILE UNIT; Reboot the Mobile Unit do to loss 
of connection. 

Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Retry (Y/N)?; Try again. Try to send or receive again, or perhaps 
ensure that the printer is cabled to the 
Mobile Unit and is on. 
 

--- 
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TIMEOUT\n\nSending Data; Mobile Unit out of the coverage 
area. 

Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

TIMEOUT\n\nReceiving Data; Mobile Unit out of the coverage 
area. 

Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Host Received Data\nAwaiting App 
Reply!; 

Mobile Unit has sent and received 
an acknowledgement from the IP 
stack and is waiting for the 
application to return data. 

Most likely a host or network issue. 
Troubleshoot the customer’s environment. 
Probable causes are Database record 
locking, application program failure, Host 
failure or network failure. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

* WAITING TO SEND  *; Mobile Unit out of the coverage 
area. 

Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

TCP Error Reading\nMAC 
Address.\nREBOOT MOBILE UNIT; 

Could not obtain the Mac Address 
from the Mobile Unit. 

Possible hardware, driver or stack problem 
Contact the Mobile Unit manufacturer. 

--- 

Invalid TIP Command; Bad internal protocol. Notify Connect over the Web incident 
reporting system. 

--- 

Session Ended\nBy User or Host; User, Host, application or network 
has ended the session. 

If the user did not end the session, most 
likely host or network issues. Troubleshoot 
the customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Server Packet Error; Bad Protocol detected. Usually a result of bad cabling, power or 
faulty transceiver. Also, will receive this if 
the Mobile Unit is in the wrong mode for 
server operation. 

--- 

  Supported Equipment Manual    •   June, 2006 4-4



  Error Message Resolution Guide 

 

Message Reason Solution Reference Tech Note 
    

Error receiving host\nlist from Server; Bad Protocol detected. Usually a result of bad cabling, power or 
faulty transceiver. Also, will receive this if 
the Mobile Unit is in the wrong mode for 
server operation. 

--- 

Unexpected Server\ndata received; Bad Protocol detected. Usually a result of bad cabling, power or 
faulty transceiver. Also, will receive this if 
the Mobile Unit is in the wrong mode for 
server operation. 

--- 

Error starting\nhost application; Connected to the server but can 
not connect to the distant end. 

Configure the server handler to access the 
host application. 

--- 

Select Host or App; Need to choose your 
Host/application destination. 

User selection required. --- 

Connecting...; Attempting to connect to the 
Host/application. 

Advisory message. --- 

TCP Error\nReading IP 
Address\nREBOOT MOBILE UNIT; 

Mobile Unit missing Network IP 
information. 

Configure the Mobile Unit with the correct 
network IP information. 

--- 

Printer start error; Could not initialize the printer. 
 
 

Cable or power issue with the printer. --- 

Battery too low\nto print; Not enough power to print. Replace the battery with a fully recharged 
battery. 
 

--- 

Paper Feed Error\nFix Then Hit Enter; Paper in the printer is not ready. Replace the paper or rethread the paper in 
the printer. 
 

--- 

Printer Error\nPrint Ended; Can not print. Check cable, battery, communication 
settings and paper in the printer. 

--- 
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User Count Exceeded.\n Session 
Ended;  

Possible authorization issue. Verify that you have the correct number of 
licenses for the number of Mobile Units you 
are using. 
 

--- 

Primary Unavailable\nTrying Alternate; First Host IP address not available 
trying the remaining addresses in 
the Host list. 

Verify the host address. --- 

APMAC.DAT Error\nSession Ended; Access point Media Access Control 
error. 

Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

MUIP.DAT Error\nSession Ended;  Mobile Unit IP Error. Most likely a Mobile Unit network setting 
issue. Troubleshoot the customer’s 
environment. 
 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Missing Subnet IP\nSession Ended;  Mobile Unit IP Netmask Error. Most likely a Mobile Unit network setting 
issue. Troubleshoot the customer’s 
environment. 
 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Error Opening File;  File is missing. Verify that the configuration files are on the 
Mobile Unit.  Or perhaps there is a 
hardware failure. 

--- 

Telnet API\nnot found; Program files are missing. Reload program files. --- 

Battery Low Warning\n\nReplace 
Battery Soon;  

Not enough power to operate the 
Mobile Unit. 

Replace the battery with a fully recharged 
battery. 

--- 

No Host List.\nPress any key\nTo Edit 
Host IP's;  

Have not configured your target 
hosts. 

Configure the target host IP addresses. --- 
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Unable to Allocate\nFont Memory; Mobile Unit does not have enough 
memory to load the fonts. 

Reduce the fonts in use or expand the 
memory in the Mobile Unit. 
 

--- 

Font Loading Error; Could not load the font. 
 
 

Ensure that the font is available to load. --- 

Printer Not Ready\nPress R to 
Retry\nC to Cancel Print; 

Can not print. Check cable, battery, communication 
settings and paper in the printer. 

--- 

Mobile Unit in\nDemonstration 
Mode\nfor TwinClient;  

Running in demo mode. Purchase a license from Connect. --- 

Connected to Host;  Successful connection to the target 
Host. 

Advisory message. --- 

Telnet Mode not\nsupported on\nthis 
Mobile Unit;  

This Mobile Unit must be used with 
a Connect Server. 

Order a Connect Server. --- 

Telnet Setup files\nnot found. 
Reload\nfiles then switch;  

Customer specific configuration 
files are missing. 

Load the configuration files into the Mobile 
Unit from Twin Client Manager. 

--- 

Switched Client to\nTelnet Direct Mode; Mobile Unit running in Telnet mode 
direct to the target Host. 
 

Advisory message. --- 

Switched Client to\nServer Based 
Mode;  

Mobile Unit running through a 
Connect server in Server mode 
usually at port 1800. 

Advisory message. --- 

Port 23 is only\nallowed in Telnet 
Mode;  

Can not set the port to 23 in Server 
mode.  Port 23 is the standard 
Telnet port. 

Advisory message. --- 

Not Enough Memory\nTo Run; Mobile Unit does not have the 
capacity to run the program do to 
memory restrictions. 

Expand the Mobile Unit memory. --- 
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Press any key; Press a key to continue. Advisory message. --- 

TwinClient Telnet;  Prompt. Advisory message. --- 

TwinClient Server;  Prompt. Advisory message. --- 

TwinClient TN3270; Prompt. Advisory message. --- 

TwinClient TN5250; Prompt. Advisory message. --- 

TwinClient TNVT/HP; Prompt. Advisory message. --- 

(c) 1991-2006 Connect; Prompt. Advisory message. --- 

Edit Menu Options; Menu Title. Advisory message. --- 

Edit Mobile Unit IP; Menu Option. Advisory message. --- 

Edit Server/Host IPs; Menu Option. Advisory message. --- 

  Supported Equipment Manual    •   June, 2006 4-8



  Error Message Resolution Guide 

 

Message Reason Solution Reference Tech Note 
    

Edit Radio Option; Menu Option. Advisory message. --- 

Edit License Key;  Menu Option. Advisory message. --- 

Run Site Survey;  Menu Option. Advisory message. --- 

Switch Client Modes; Menu Option. Advisory message. --- 

Run TwinClient; Menu Option. Advisory message. --- 

Exit to OS;  Menu Option. Advisory message. --- 

Printer may not be\nplugged in 
or\nturned on!; 

Can not print. Check cable, battery, communication 
settings and paper in the printer. 

--- 

OUT OF RANGE OF BASE; Mobile Unit out of the coverage 
area. 

Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

CONNECT SERIAL CABLE; Serial cable not connected to the 
Mobile Unit. 

Check cable, battery and communication 
settings for the Mobile Unit. 

--- 

REMOVE SERIAL CABLE; Remove serial cable from to the 
Mobile Unit. 

Check cable, battery and communication 
settings for the Mobile Unit. 

--- 
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PLACE IN CRADLE; Place the Mobile Unit in the cradle. Advisory message. --- 

REMOVE FROM CRADLE; Remove Mobile Unit from the 
cradle. 

Advisory message. --- 

ACQUIRING CRADLE BUS;  Attempting to access the cradle 
through the serial port you have 
configured. 

Advisory message. --- 

Printer Out\nOf Range; Printer out of the coverage area. Most likely a range, access point or radio 
issue. Troubleshoot the customer’s 
environment. 
 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Connection Refused\nBy Host; You connected to the target host 
but the host disconnected you. 

Verify that the configuration file has the 
correct Mobile Unit type and New 
environment variable set.  Fallback to the 
Connect Default to verify the connection. 

--- 

Connection Timed Out; You connected to the host but did 
not logon in the appropriate time so 
the host disconnected you. 

Modify the Host parameters for login. --- 

Connection Failed\nHost Not 
Responding; 

Could not connect to the Host. Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Connection Failed\nHost Unreachable; Could not connect to the Host. Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Mobile Unit Out\nOf Range, 
Unable\nTo Transmit; 

Mobile Unit out of the coverage 
area. 

Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 
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Mobile Unit Out\nOf Range, 
Unable\nTo Receive; 

Mobile Unit out of the coverage 
area. 

Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

--- 

Printer Not\nResponding; Can not print. Check cable, battery, communication 
settings and paper in the printer. 
 
 

--- 

Printer Out\nOf Range; Printer out of the coverage area. Most likely a range, access point or radio 
issue. Troubleshoot the customer’s 
environment. 
 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Print Complete; Prompt. Advisory message. --- 

Reprint (Y/N)?; Yes or No prompt for a reprint. Advisory message. --- 

WARNING;  Prompt. Advisory message. --- 

Turning power off\nduring a 
session\nwill cause the\nprogram to 
restart; 

This Mobile Unit will disconnect the 
session if powered off. 

Mobile Unit manufacturer limitation. 
Advisory message. 

--- 

Are you sure (y/n)?; Yes or No prompt for a 
confirmation. 

Advisory message. --- 

You Sure? (YyNn); Yes or No prompt for a 
confirmation. 

Advisory message. --- 
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Domain Name Server\nNot Set; DOMAIN NAME SERVER not 
configured. 

Configure the Mobile Unit with the correct 
network IP information. 

--- 

Domain Name Server\nQuery Memory 
Error; 

Memory error on the Mobile Unit Expand the Mobile Unit memory or return 
the Mobile Unit for repair. 

--- 

Domain Name Server\nQuery Sending 
Error; 

Mobile Unit out of the coverage 
area. 

Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Domain Name Server\nQuery Receive 
Error;  

Mobile Unit out of the coverage 
area. 

Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Domain Name Server\nUnavailable; Could not connect to the DOMAIN 
NAME SERVER. 

Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Error loading\nparameter file; Could not load the parameter file. Reload the correct configuration files. --- 

Could not open\ntelnet interface; Could not Telnet. Reload the program files. --- 

Could not set\mtelnet options; Could not use the Telnet 
configuration. 

Reload the correct configuration files. --- 

Setup file\nsetting mismatch\nReload 
Setup; 

Emulation program selected is not 
compatible with the configuration 
file on the Mobile Unit. 

Remove the emulation and configuration 
files. Run clear Telnet on the Mobile Unit 
then reload the Mobile Unit with the proper 
emulation and configuration files. 

--- 
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Display formatting\ntoo large 
for\ncurrent screen; 

Mobile Unit does not have enough 
memory to run your configured 
reformatted screens. 

Expand the Mobile Unit memory or order a 
server from Connect. 

--- 

Mobile Unit\ninitialization error; Mobile Unit problem. Return the Mobile Unit to the manufacturer 
for repair. 

--- 

Host/App/Network\nclosed the session; Customer’s environment 
disconnected the Mobile Unit 
session. 

Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Disconnecting...;   Prompt. Advisory message. --- 

Scan Barcode; Bar code scanning test. Advisory message. --- 

Enter Setup\nPassword;  Prompt. Advisory message. --- 

Enter Profile \nPassword; Prompt. Advisory message. --- 

Host IP; Host IP address prompt. Enter target host IP address. --- 

Host Name; Host name prompt. Enter target host Name. --- 

Port; Host IP port required. Enter 23 for Telnet or 1800 for a Connect 
server. Could also be a different number 
depending on the customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 
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Mobile Unit Type;  Prompt. Advisory message. --- 

WARNING: This will \nend any\ncurrent 
session; 

Prompt. Advisory message. ---

Continue (Y/N)?; Prompt. Advisory message. --- 

HOST ENTRY; Prompt. Advisory message. --- 

VT(100/220)/HP Setup; Prompt. Advisory message. --- 

Mobile Unit Info; Prompt. Advisory message. --- 

Emulation Setup; Prompt. Advisory message. --- 

ANSI Setup; Prompt. Advisory message. --- 

Miscellaneous Setup; Prompt. Advisory message. --- 

Mobile Unit Type; Prompt. Advisory message. --- 
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Control Codes; Prompt. Advisory message. --- 

Local Echo; Prompt. Advisory message. --- 

<BK SP> Sends; Prompt. Advisory message. --- 

New Line Mode; Prompt. Advisory message. --- 

Insert Mode; Prompt. Advisory message. --- 

Autowrap Mode; Prompt. Advisory message. --- 

Cursor; Prompt. Advisory message. ---

EMULATION SETUP; Prompt. Advisory message. --- 

Mobile Unit Type; Prompt. Advisory message. --- 

Local Echo; Prompt. Advisory message. --- 
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Map Underline; Prompt. Advisory message. --- 

Break Key; Prompt. Advisory message. --- 

ANSI Setup; Prompt. Advisory message. --- 

Control Codes; Prompt. Advisory message. --- 

Backspace Key; Prompt. Advisory message. --- 

MISCELLANEOUS SETUP; Prompt. Advisory message. --- 

Test Options; Prompt. Advisory message. --- 

Login Options; Prompt. Advisory message. --- 

TEST OPTIONS; Prompt. Advisory message. --- 

Printer Test; Prompt. Advisory message. --- 
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Scan Code Test; Prompt. Advisory message. --- 

LOGIN OPTIONS; Prompt. Advisory message. --- 

User Name; Prompt. Advisory message. --- 

User Password;  Prompt. Advisory message. --- 

ON; Prompt. Advisory message. ---

OFF; Prompt. Advisory message. ---

Map; Prompt. Advisory message. ---

Don't Map; Prompt. Advisory message. --- 

Enable Break; Prompt. Advisory message. --- 

Disable Break; Prompt. Advisory message. --- 
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7 bit; Prompt. Advisory message. --- 

8 bit; Prompt. Advisory message. --- 

Send Delete; Prompt. Advisory message. --- 

Send Backspace;  Prompt. Advisory message. --- 

Mobile Unit Setup; Prompt. Advisory message. --- 

Scanner Options; Prompt. Advisory message. --- 

Program Options; Prompt. Advisory message. --- 

Special Options;  Prompt. Advisory message. --- 

Beeper Options;  Prompt. Advisory message. --- 

Exit to DOS; Prompt. Advisory message. --- 
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Backlight Time; Prompt. Advisory message. --- 

Enter Key Action; Prompt. Advisory message. --- 

Reset Options; Prompt. Advisory message. --- 

Font Size;  Prompt. Advisory message. --- 

Portable Printer; Prompt. Advisory message. --- 

Reprint Option; Prompt. Advisory message. --- 

Data IDs; Prompt. Advisory message. --- 

Internal/External; Prompt. Advisory message. ---

Modify Beeps; Prompt. Advisory message. --- 

Message Beeps;  Prompt. Advisory message. --- 
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Scan Identifier; Prompt. Advisory message. --- 

AID Scan Setup; Prompt. Advisory message. --- 

Long Scans; Prompt. Advisory message. --- 

Scan Send;  Prompt. Advisory message. --- 

Yes; Prompt. Advisory message. ---

No;  Prompt. Advisory message. --- 

Normal; Prompt. Advisory message. ---

Double Wide; Prompt. Advisory message. --- 

Double High; Prompt. Advisory message. --- 

Double High and Wide; Prompt. Advisory message. --- 

  Supported Equipment Manual    •   June, 2006 4-20



  Error Message Resolution Guide 

 

Message Reason Solution Reference Tech Note 
    

     

     

     

     

Errors Only; Prompt. Advisory message. --- 

Automatic; Prompt. Advisory message. ---

All Messages;  Prompt. Advisory message. --- 

Reject; Prompt. Advisory message. ---

Truncate; Prompt. Advisory message. ---

Split;  Prompt. Advisory message. --- 

Do Not Send; Prompt. Advisory message. --- 

Always Send; Prompt. Advisory message. --- 

Last Field Only; Prompt. Advisory message. --- 

Internal; Prompt. Advisory message. ---
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External; Prompt. Advisory message. ---

none; Prompt. Advisory message. ---

monarch; Prompt. Advisory message. ---

pddumb; Prompt. Advisory message. ---

comtec; Prompt. Advisory message. ---

rascal; Prompt. Advisory message. ---

codewriter; Prompt. Advisory message. ---

comtec(S); Prompt. Advisory message. ---

User Name; Prompt. Advisory message. --- 

Password;  Prompt. Advisory message. --- 
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Frequency:      Hz; Prompt. Advisory message. --- 

Duration:       ms; Prompt. Advisory message. --- 

Delay:          ms;  Prompt. Advisory message. --- 

Select Scanner; Prompt. Advisory message. --- 

Setup Scanner; Prompt. Advisory message. --- 

Scan Test; Prompt. Advisory message. --- 

Scan Operation;  Prompt. Advisory message. --- 

Laser; Prompt. Advisory message. ---

Contact/Pulse; Prompt. Advisory message. ---

Contact/No Pulse; Prompt. Advisory message. --- 
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Auto/Pulse; Prompt. Advisory message. ---

Auto/No Pulse; Prompt. Advisory message. --- 

Wand Simulation;  Prompt. Advisory message. --- 

VT100; Prompt. Advisory message. ---

VT220; Prompt. Advisory message. ---

HP700;  Prompt. Advisory message. --- 

SETUP; Prompt. Advisory message. ---

Mobile Unit IP/Radio; Prompt. Advisory message. --- 

Host List; Prompt. Advisory message. --- 

NULL; Prompt. Advisory message. ---
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